
Release Notes / Update History

Bookʼem!  5.2.3
Released 3/1/2010

Bugs Fixed
Empty lines in printed letters are respected.

Bookʼem!  5.2.2
Released 2/17/2010

Bugs Fixed
Corrected invoice font issue (Windows only.)

Bookʼem!  5.2.1
Released 1/28/2010

Bugs Fixed
Web export/import form tab control properly initialized.
New Features
Sample web import definition file added to demo.

Bookʼem!  5.2
Released 1/5/2010

New Features
Customer data and reservations may be received directly from a website form. This feature re-
quires some customization due to differences in the form and content of data coming from your 
site.
When entering a payment on an invoice, the payment amount no longer defaults to the total due 
on the invoice, unless the “Payment amount defaults to Invoice Balance” option is set on the In-
voices page of Preferences.
Event waitlists may now be printed.

Bookʼem!  5.1.3
Bugs Fixed



Using the Zipcode Lookup module, if the zipcode begins with zero, it gets dropped and the 
search doesn't find it. So if you entered 01029 the program looks for 1029 and comes up empty.
Also in the Zipcode module, if multiple cities were found and a selection list presented, the city 
and state were entered in the City field
New Features
The SMTP port for email sending may be changed on the Communications page of Preferences. 
This should be done only if your ISP requires a specific port be used.

Bookʼem!  5.1.2
Bugs Fixed
Reservation payment information was not being updated when payments were entered from Re-
ceivables or the Customer Account area.
Some quirks in entry of Customer Sources were fixed,.
Sources imported from older versions weren’t being recognized if they had not been on the selec-
tion list.  Now, they are added to the Source table and the Customer records are tagged, and those 
sources are categorized as Obsolete, the assumption being that they must have been deliberately 
removed from the old selection list. 
Several objects in some database windows were not moving properly when the window was re-
sized.
When returning to an Event window after opening an Invoice, the buttons were disabled even 
though a Reservation was still selected.
New Features
The old Schedule by Calendar feature has been restored.
The Datadump and Text Export functions now require that no other users have the program open. 
This is to ensure data integrity.
The Quicktime detection routines have been upgraded.

Bookʼem! 5.1.1
Bugs Fixed
Imported events from older versions were not properly tagged with Event Type

Bookʼem!  5.1
Bugs Fixed
One-time events created from the Home Screen and the One-time Event List would not allow a 
reservation to be taken. An error “Master type not set” was shown.
Email attachments were not working when sending to a selection of records using the Mail 
Merge function from the Customer database.
When adding a new customer record while taking a reservation, the credit card fields were non-
enterable.



When adding a new customer record, the Custom Field page was not accessible.
Credit card numbers printed with asterisks on the Receipts and Receivables reports even if the 
user has credit card access. (They will still always print with asterisks on rosters.)
Several windows were opening to the wrong size, obscuring entry areas.
In several entry areas copy and paste were not working.
New Features
Sales tax functions overhauled
Payment details and Reservationist added to invoice
10 user-defined custom fields have been added to the Customer table
Credit card numbers are stored in encrypted form, with administrator control over user access. A 
new field to save the 3-digit security code has been added.
2 new payment types have been added: Voucher and Other. Records in the Companies table may 
be marked as a Voucher Source. Once marked, the issuing company may be selected when enter-
ing a payment by voucher.
New fields have been added to the Transactions table to store credit card info, check numbers, 
gift certificates, and voucher info. Previously, this info was just written to the Notes area.
The new Roster Financials report is available from the Print command from the File menu at the 
Home screen. This lists all people reserved for all events during the selected date range and item-
izes their charges for reservations, tax, any 2 Item Types. It also lists payments and balance due.
The Daily Receipts report (Print command from File menu at Home screen) has been rewritten to 
display the new Transactions detail and itemize by payment type.
The Receivables report (Print command at Receivables) has been reformatted to print portrait. 
An invoice summary has been added, and credit cards from the customer table are printed.
It’s now easier to add custom home screen pictures. Just add them to the Pictures folder and se-
lect in Preferences.

Bookʼem!  5.0
Bugs Fixed
Dozens of minor quirks and glitches fixed.
New Features
Larger, resizeable windows throughout the program
Client and Server may now run on the same machine (dual processor recommended)
New Report Editor
Mac OS X native
Enhanced Quote Estimator functions, including printing
Enhanced Returned Mail Handler
Any invoice may be billed to any third party (the payer does not need to have a reservation)
Membership module featuring expiration warnings, discounts, renewals, photo import, ID card 
printing



Facilities handling with reservations time-in/time-out independent of session hours
Check-In/Check-Out attendance function
Google searches and Mapquest lookups from the Address Book
SMTP authentication for email sending
New Staff assignment viewer and reporting
User-settable Holiday date list, which auto-scheduling functions skip
Auto-purge duplicates from Label Spool
Easier display of custom homescreen pictures
Custom field selector column on database lists

Bookʼem!  4.5.5
Bugs Fixed
A crashing bug that occurred under certain conditions when using the Import/Export editors was 
fixed.
The current table was set to read-only state when returning from the Find Duplicates utility.

Bookʼem!  4.5.4
Bugs Fixed
Entering payment from Account section of Customer record would set the table to read-only 
state.
New Features
Fields added to Customer table: Cell Phone, Emergency Contact, Emergency Contact Phone. 
Data is printed on rosters if present.
Field added to Staff, Contacts, and Destinations tables: Cell Phone
Compatibility with Windows XP Security Update KB824141

Bookʼem!  4.5.3
Bugs Fixed
The last day of multi-day events was not appearing on the Calendar, nor being counted in user 
day reports.
While making a reservation, if all in party were not billed, 'Add Others' request was not appear-
ing.
If a credit card payment was entered from the Accounts section of the Customer record, the de-
fault table form was not properly reset.
New Features
Word wrap (in pixels) has been added as a settable Preference. This applies only to the plain text 
letter writer.



Bookʼem!  4.5.1
Bugs Fixed
Using the plain text area for mail merge, some lines were wrapping incorrectly during printing.
On some Windows computers the program would stall sometimes during startup before the home 
screen opened. 

Bookʼem!  4.5
Bugs Fixed
The "Description" button on the Calendar has been fixed and now finds the Master Description if 
there is none for the Event.
In the Create Weekly Schedules window, if the calendar date selectors were used, an error was 
generated when creating events. This has been fixed.
Location maps when attached to confirmation emails were sometimes not compatible with some 
operating systems or email clients. This has been fixed. This function now requires free Quick-
time software to be installed.
A rare data entry sequence while scheduling event sessions could have reversed the start and end 
date of the event. 
Reservations are now properly recalculated when an Invoice's Cancel button is pressed.
New Features
Email attachment system added for confirmation and mail merge letters, including internal 
document storage and management server. To maximize compatibility with various operating 
systems, filenames must not exceed 32 characters in length and must have a valid 3-character 
extension. The extension must reflect the file's actual type, although there is no way Book'em! 
can test for that. Examples of valid filenames are Release.pdf (Acrobat file) and Mountain.jpg 
(JPEG picture.)
Event Description added to Merge Data popup for confirmation letters.
Buttons have been added to load the Return Address Logo and Location maps directly from disk 
files without copy/paste. This function requires free Quicktime software to be installed.
The Postal Return Handler has been renamed the Returned Mail Handler, and has been updated 
to deal with bounced email addresses.
Using the close box now completely closes a window, instead of leaving it active but hidden.
TAB order adjusted on Quote Estimator.
Enter and Return key no longer closes the Calendar
5-digit phone extensions are now recognized.
The Create Reservation window has been reworked for data entry ease. The default action may 
now be set to "None" as well as "Reserve" or "Open Customer Record." The action is performed 
when a selected line is double-clicked or the keyboard's Enter key is pressed. The Reserve button 
is fired by CTRL-R (Windows) or Command-R (Mac), and the Open Customer button is fired by 
CTRL-O (Windows) or Command-O (Mac).
Overbooking warnings are more emphatic: a sound effect plus flashing text has been added.



Waitlist deposit amount now always defaults to zero.
If any people are waitlisted for an event, the total is displayed in the Info box on the Home 
Screen and Calendar.
More detailed error reporting added to email send procedure.
Multiple email addresses separated by commas may now be added to the "To" line at the time of 
sending. Each address will be checked for valid form.
When the Add Session button is clicked from the Sessions page of the Edit Event window, a se-
lection calendar is opened which shows all of the existing session dates in blue. By default, the 
day following the last existing date is preselected and highlighted in black and yellow.
Changes for New Users
The Start Real Datafile function now clears the demo return address.
When restarting after using the Start Real Datafile function there is no prompt to import demo 
data.
If the computer is not set to display 4-digit years, a warning is given on each startup but the pro-
gram is allowed to run.

Bookʼem!  4.1.2
Bugs Fixed
With the 4D Write word processor installed, confirmation letters were not printing if no map or 
directions were included.
The return address in the footer area of confirmation letters printed using the 4D Write word 
processor was being truncated at 80 characters.
Using the plain text editor, letters were not printing more than one page.
New Features
Windowing methods were changed to accommodate user-adjustments to screen resolution.
 
Bookʼem!  4.1
Bugs Fixed
When doing an Add to Party, and the number of listed people is less than the size of the party, 
waitlist warnings would come up, and the size of the party would be increased. This has been 
fixed.
New Features
Add Currency Format setting to Preferences
Enable the Print command from Customer record during reservation process. Use CTRL/Cmd-P
Add Mail Type and Mail Pref to Customer printout
Show session start time on Calendar
Add calendar select button to Event Sessions list for Windows XP (already working for other 
OS)
The plug-in DispList has been replaced with native code



The plug-ins AreaList, PrintList, and Win32api have been upgraded to the latest versions
The plug-in FontTools is no longer necessary and has been removed.

Bookʼem!  4.0
Bugs Fixed
Corrected situation (rare) where previous minor programming error could be misinterpreted as 
low memory condition when opening event window.
Fix problem in date range search in User Days report.
Fix problem with enabling Base Selection items in the list screen windows
Fix problem with new events recognizing newly saved locations.
Many minor quirks and bugs were fixed.
New Features
4th Dimension version was upgraded to 6.7.x. This provides compatibility with new operating 
systems, increased speed, email and other internet functions.
The ability to send confirmations and merge letters as email has been added. Basic email settings 
are made in the Communications page of Preferences.
Expanded customer mail preference tagging. The old “No Mail” setting has been replaced with a 
selection popup with 4 choices: 
• All Mail,
• All Except Promos
• Confirmations Only
• Don’t Send Anything.
Mail merge letters may be tagged “Promo”, and customers tagged “All Except Promos” will be 
skipped when printing them.
Customer records may be tagged as preferring to receive email or hard copy. 
A letter may be printed or sent via email to a selection of records. The "Smart Mailer" option will 
choose print or email for each record in the selection based on data in the record and the system 
settings.
When printing confirmations, force a hard copy print by clicking the name with the Alt (Win-
dows) or Option (Mac) key down. A letter will print regardless of email settings or validated ad-
dress.
Button added at all Email fields (Customer, Staff, Contacts, Destinations) to open email software 
and pre-address a new message 
Add 'Print Footer' checkbox when printing confirmations and letters. The footer may be set to not 
print if the Business Name as entered in the Return Address form is contained in the body of the 
letter. If the plain text word processor is used and the checkbox is deselected, the business name 
will be appended to the body if it is not present.
If confirmation letter printing is cancelled during a print preview, the reservation is not tagged as 
having been printed. 
Generate default confirmation letters if they don't exist.



Change name of menu item "Send Letter..." to "Send Mail..." at people table list screens
Non-consecutive day event scheduling (class sessions). Recurring Masters may have session info 
stored as a weekly pattern and the number of weeks to repeat. Actual events have sessions stored 
as actual dates and times.
2-tier source tracking with statistics. Customer sources may be organized under user-created 
categories.
Customer Sources added as an accessible table under the Database menu from the Home Screen. 
With the list of sources open, the Source Category Manager is available from the Tools menu. 
From here, categories may be added and sources placed in them. Also, Category selection may 
be made from within any Source record
Each Source record displays a list of Customer records tagged with the source and the number of 
events each has reserved. The total revenue generated by the Source is totaled, and the average 
per person is calculated.
Support for 4d Write word processor (located in the word processor folder) has been added. Fea-
tures character and paragraph formatting and stylesheets, tabs, rulers, alignment, and enhanced 
data embedding. Available as a paid option.
Support for the Macintosh-only SuperText plug-in has been dropped for compatibility reasons.
Larger, easier to use, screens throughout. Where appropriate, window sizes have been enlarged, 
and screen forms redesigned for usability.
The main Customer form is now used to display Customer records from the Event windows.
The reservations process has been streamlined by replacing the series of small sequential win-
dows with one multi-functional controller.
When making a new reservation, if letters are typed while 'Party of' quantity is highlighted, the 
default number is not cleared and the typed letters are moved to the 'Search for' box.
Add preference to force "policy inform" selection while reserving.
Under Windows, after adding new Customer record while taking reservation, focus is shifted to 
the Reserve button. (This is irrelevant under Macintosh since buttons don't get focus.)
Event categories have been added to Recurring Master event records, and a popup to the top left 
of the Home Screen. 
Calendar functions have been expanded. The window is larger, the Events and Appointments ar-
eas are approximately equally-weighted. Description, Schedule, and Pickups buttons have been 
added to the Events area.
Individual label printing is now supported in Windows. The Print Label function has been ex-
tended to Staff, Contacts, and Destinations.
Direct read-only access to line items and reservations databases has been added, to increase re-
porting possibilities. 
A memory tuning thermometer has been added to Preferences, allowing internal process memory 
to be adjusted based on the memory installed on the computer. 
Secure user log-off without program exit has been added to the File menu at the Home Screen. 
The current user may log off, and the program will remain open but cannot be used until another 
log-in is completed.
The floating Windows Palette has been removed, and a Window menu added to the menu bar.



Four related, confusing popup menus in the footer of the Customer database list have been re-
placed with one heirarchal popup. All of the old functions were retained, and a Mail List sub-
menu has been added. Separate selectors for Skill Level and Total Events have been added.
Web URL field added to Contacts record (Address Book), and a button to open the site. If there's 
no web address entered, a web search will be initiated for company name + city or person's name 
+ city. CTRL-click (Windows) or Command-click (Mac) the button for a broadened search.
Total Receivable calculated for Checkbox Roster under Rosters by Day function
Add error reporting mechanism to DataDump import
If there are fewer people entered than total reservations, the room list report skips the room type 
calculation
Smart Date feature added. For any date field, TAB in and type:
   month/day only and current year is added
   t = today
   m = first day of current Month
   h = last day of current montH
   y = first day of current Year
   r = last day of current yeaR
 If there already is a value in the date field,
   + = add a day to the date
   - = subtract a day from the date
Modify 'Delete All Holds' function to tag, rather than physically delete.
The US zipcode lookup module has been moved to an internal database table.
Add preference to validate non-US/Canada addresses with no state or zip
If record has a value in Country field, it's placed on a new last line
If a link to a Company is established for an existing Customer record, the address is refreshed 
immediately.
Country field added to Destinations table & Contacts table
Implement individual printing from Label Spool record
Disable "New" button on database QuickSearch for several tables.
Help buttons added to Event Print dialog.
Add default Mail Preference for carryover addresses.
Print credit card numbers on simple roster if preference is on.

Bookʼem! 3.6
Bugs Fixed
Opening a reservation (alt-doubleclick on Windows, option-doubleclick on Mac), the pickup 
point displayed was the customer default and not the point selected for the reservation.
When using the plain text letter writer, confirmation letters ignored a company address.
When applying payments to a selection of invoices from Receivables, invoices not connected to 
an event were ignored.



If the Edit Event window was opened directly from the event itself, and the event was cloned, 
errors were generated when returning to the event.
The Clone button on the One-Time Event list did not work.
New Features
The “cancel reservation” functions have been completely rewritten for consistency. Now, when-
ever a reservation is cancelled, a line item is created on the invoice that the reservation was billed 
on reflecting the cancellation whether a cancellation charge was billed or not. Payments are never 
moved from one invoice to another.
When applying payments to a selection of invoices from Receivables, processing may be stopped 
by Alt-clicking (Windows) or Option-clicking (Mac) the Cancel button.
Confirmation is now required after entering or modifying a password, to ensure against acciden-
tal lockouts.

Bookʼem! 3.5.2
Released 7/10/2000

Bugs Fixed
Errors were sometimes generated when returning to the Calendar or One-Time Events list from 
the Edit Event list.
The floating “Windows” palette had become unfunctional on Windows computers.
A few users were not able to save changes to the invoice footer message between restarts.
When moving a customer whose reservation had been on someone else’s invoice to one of their 
own, and there were payments on the original invoice, the message box did not close before dis-
playing the Redistribute dialog, preventing data entry. 
When cloning an event with a sponsorship, sometimes the sponsorship was not successfully 
cloned.
An obscure way to save a Transaction record with a zero amount has been eliminated.
Occasionally menus were not enabled after closing a modal dialog.
Several small bugs that caused runtime errors were fixed.
New Features
Event listings in the Reschedule dialog are now sorted by start time as well as date.
When an event is selected in the Reschedule dialog, information is now displayed for location, 
cost, and start time.
A new customer account may be created by Control-clicking (Windows) or Command-clicking 
(Macintosh) the Account button on the Customer input form.
The new Check Staff button on the Calendar displays all active staff, with a mark by the name of 
anyone scheduled to work on the selected date.
The invoice print form has been tweaked a bit.
The NCOA import feature has been updated for compatibility with new formats from 
www.listcleanup.com.

http://www.listcleanup.com
http://www.listcleanup.com


A new preference has been added to allow the right-click/control-click Windows menu to be 
turned on or off has been added. The setting is saved for each user.

Bookʼem! 3.5
Bugs Fixed
The tax rates were not properly initialized before creating a sponsorship invoice, when using the 
Add to Party button, and when opening an invoice from Receivables.
Line items for reservations could be manually set to zero (or less than zero), which eventually 
produces errors in other functions. The only supported method of canceling a reservation is to 
use the “Cancel Res” button on the Event window.
All functions in the reservations window now recognize holds placed by other users.
A crashing bug when transferring payments while moving a reservation from one invoice to an-
other has been fixed.
New Features
Support has been added for the optional 4D Write word processor.
Compatibility with Mac OS 9 has been added.
A new preference has been added to control whether customer credit card numbers are printed on 
the Checkbox Roster. It’s located on the Reservations page of Preferences and is settable by Ad-
ministrators only.
The list of invoices in the Account window from the Customer input form may now be navigated 
with the up and down arrow keys.
Speed improvements were made to the Receivables list.
The Events list on the Calendar is now sorted by start date (descending) and start time (ascend-
ing).

Bookʼem! 3.2.2
Bugs Fixed
Error found in parameter passed to plug-in command in several locations (2nd parameter of 
AL_UpdateArrays).

Bookʼem! 3.2.1
Bugs Fixed
Clicking the “Go To Today” button on the calendar found appointments and tasks for the current 
user instead of the selected user from the popup.
New Features
Network components upgraded to version 6.5.13.

Bookʼem! 3.2



Bugs Fixed:
When adding a reservation to an event with a zero cost, an invoice is created for the reservation 
but not automatically opened, as is the usual behaviour.  That invoice was locked until another 
reservation was taken by the same user (for any event), or that user quit the program.
Zero balance invoices from cancelled reservations were appearing on the Receivables list. 
If some characteristics of an event were changed in the Create Weekly Schedules window, add-
ing more days for the same event would default to the modified values.
When creating a new confirmation letter on Windows, an alert was shown warning that the letter 
could not be saved without a name, even though the letter was named.
In confirmation letters, invoice balances were rounded off to whole dollars. The correcrt amount 
is now printed.
A bug which sometimes caused Windows clients to crash when editing a custom label has been 
fixed.
When rescheduling into an event with a limit of zero, an alert warned that the event was over-
booked. The zero-limit event is now correctly interpreted as unlimited.
When the Edit Event window was opened by clicking the grey event name button from an event 
window, sponsorships added were not saved.
New Features
If the computer is shut down with Book'em running there is much less chance for data corruption 
to occur. This applies only if the Shut-Down command is issued and will not help if the power is 
suddenly lost or the plug is pulled.
Window positions are now remembered between sessions for the Calendar, Address Book, One-
Time Events List, the Reservation Finder, Label Spool, Receivables, Transactions, Journal and 
all tables accessed from the Databases menu. The positions are remembered for each computer.
A new preference, “Clarify List Selection,” has been added which controls what happens when a 
menu item that performs an action on a selection of records from any of the Database menu ta-
bles is chosen. If “Clarify List Selection” is on, a dialog is shown that  allows the user to specify 
whether the command is applied to the current selection, a direct selection, or all records in the 
table. This preference is settable for each user.
When cancelling reservations, posting a cancellation charge to the invoice is now directly sup-
ported.
When cancelling the reservation of an invoicee, if another person on the same invoice is not can-
celling and a cancellation charge is applied to the original invoicee, a second invoice is created 
and the user may redistribute payments already received.
When the line item quantity of a reservation is decreased on an invoice, Book’em! will now ask 
if the size of the party is to be decreased when saving the invoice.
The credit card entry window that opens when posting a payment or refund now displays the cus-
tomer address information and the payment amount.
Customers’ credit card numbers no longer print on the checkbox roster.
Invoices may now be opened, and payments applied, directly from the Account area of the Cus-
tomer form.



When event masters are clicked at the home screen, occurrences are now sorted by date and time, 
instead of just date.
A mechanism has been added for custom report access.
A new preference has been added that determines whether rosters are sorted by name or kept to-
gether by party (the original and default method). This preference is settable by administrators 
and is located on the Reservations tab.
On Macintosh only, a ‘Print Label’ button has been added to the small customer entry screen that 
opens when taking a reservation or double-clicking from an event window.
A progress thermometer has been added to the welcome startup window.
The types of pictures that may be used for the custom home picture have been expanded to in-
clude .wmf, and .emf.

Bookʼem! 3.1
Bugs Fixed:
When entering a location that doesn’t already exist in the database to a Master or Event record, 
the entered name would not carry over to the Location record, forcing the user to re-enter it.
Choosing a mailing, that had not been applied to any customer records, from the popup at the 
bottom of the Customer list screen would sometimes cause a crash.
Some distracting elements of invoices printed under Windows have been cleaned up.
A bug that could cause crashing while editing custom mailing label formats under Windows has 
been fixed.
Sometimes after a window was brought to the front it would not fully redraw.
When a day is clicked on the Calendar, appointments were listed for the current user regardless 
of the user name selected from the popup. The list now shows appointments for the user selected 
in the popup.
New Features
Invoice due date settings have been changed to allow it to default to a number of days relative to 
the event start date. Administrators please open Preferences and make this setting.
The ‘Create Weekly Schedules’ screen now offers the Save/Cancel option.
To ensure year 2000 compliance, Book’em! now insists that users set the computer to display 4-
digit years. On Macintosh this is done in the Date & Time Control Panel, on Windows it is done 
in the Regional Settings Control Panel. Date entry may still be done using only 2 digit years and 
the century will be interpreted based on the pivot year 25.
Append a 5-digit numeric zipcode (with no space or punctuation) to any portion of lastname-
space-firstname in many customer search areas to filter the search by zip. Currently implemented 
from New Reservation and Assign Sponsor buttons, the Reservation Finder, and the Postal Re-
turn Handler.
Base selections are no longer created automatically when entering one of the primary lists from 
the Databases menu. Choose ‘Create Base Selection’ from the Tools menu at a list screen to start 
a bucket.



The command ‘Remove from Base Selection’ has been added to the Tools menu at the list 
screens.
The NCOA updater routines are fully implemented. This allows a mailing list to be exported and 
sent to www.listcleanup.com, or other list processor offering the same service, to be checked 
against the (US) National Change of Address lists of the USPS. The database will be automati-
cally updated (also with zip+4 updates) upon importing the return .dbf file. Please consult with 
Outside Technology before using this feature.
Previous versions of Book’em! sorted lists automatically every time the selection changed. With 
large numbers of records this could be quite slow. Now, Autosort may be toggled on or off just 
by selecting it from the Tools menu at any list screen or marking a checkbox on the QuickFind 
dialog when opening an area from the Databases menu. Each user may set the AutoSort state at 
program startup in Preferences.
When opening the Transactions database, Book’em! now broadens the date range until a range 
that contains records is found. The order is Month to Date, Last Month, Last Quarter, Year to 
Date, and All Transactions.
Progress thermometers have been rewritten in native code (in previous versions an external plug-
in was used.) This provides greater stability and control.
Book’em! now checks at startup to be sure the correct version of 4D Server and Client is being 
used.

Bookʼem! 3.0
Bugs Fixed:
Occasionally on Windows95 scrollbars would temporarily stop working.
Rescheduling a reservation into an event with an open window produced unpredictable results.
Rescheduling into a one-time event is now possible.
The sequential multiple payment entry feature in Receivables has been fixed.
Settings for default payment type and liability/cancellation message now are saved correctly.
Some print reports stored on disk were not being found correctly.
The list of fields in the Check Duplicates utility contained garbage characters on Windows.
The last line of printed text areas was sometimes not printed.
Many trivial glitches have been fixed.
New Features
A mechanism that allows synchronization between the main database and up to 9 remote com-
puters has been added. See the section “Synchronization” below.
An optional password security system has been added. See the section “Passwords” below.
Entire trips may be sold to a “sponsor”. The sponsor may be charged a flat rate and/or a per res-
ervation charge. Each reservation may also be charged if desired.
The new “Event Quote Estimator” creates quotes for custom trips based on user-entered default 
costs. Once standard costs for such things as wages, transportation, food, insurance, equipment, 

http://www.listcleanup.com
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etc. are saved, quotes may be generated simply by entering number of people, days, meals, and 
miles. The quotes may be saved and one-time events may be generated from them.
A new “Quick Search” feature allows easy selection of records using various fields when enter-
ing any of the people tables or other databases.
Many Preference settings that previously were made for the entire system are now settable for 
individual users. See the section “Preferences” below.
The new Items Needed report shows all material needed for an event. This is drawn from the 
non-reservation items added to invoices and may include such things as food, boats, wetsuits, 
gift certificates, etc., organized by item type. A new preference setting allows zero-cost items to 
be non-printable on the invoice, and any item record may be flagged to be excluded from the 
Items Needed report.
The method for selecting confirmation letters has been completely rewritten. Confirmation letters 
are now named, and may be selected in the recurring master and individual event records. Any 
existing confirmation letter may be selected from a popup when printing.
The hotels/destinations module has been greatly expanded, allowing multiple destinations for 
each day of a trip.
A pick-up/drop-off itinerary with times may be specified for an event. Pick-up locations may be 
specified for reservations, and bus manifests produced.
Guide certifications may be tracked. Easily check for expiring certifications up to a specified 
date, and view certificate info when assigning employees to an event.
Employees assigned to an event may be designated with their job, such as “Guide”, “Assistant”, 
“Driver”, etc.
Upcoming assignment reports may be printed for staff.
New companies table, related to customers, has been added.
International addresses are now supported, and phone number formatting is suppressed for re-
cords whose address is outside the US or Canada.
The Account button on customer entry forms now shows all charges, payments, debits, and cred-
its, and the customer’s current balance.
A button to create a new customer record has been added to the Reservation Finder. This pro-
vides a handy way to search before adding customers not making a reservation.
The feature that displays events with no staff assignments while running Payroll now allows 
empty events to be ignored. Also, the complete event record may be opened directly from this 
window.
A new calendar has been added which emphasizes the new contact management and marketing 
features.
One-time events may now be added directly from the calendar.
When adding one-time or recurring events from the Calendar, the event definition window opens 
for instant modification.
One-time events may now be cloned.
A new popup menu on the Event window is an alphabetical reference to all people with reserva-
tions for the event. This is very handy when more than 20-25 reservations exist.



A new popup on the footer of the Customers List is numbered 1-10 and will find all customers 
who have reserved into the selected number of events or greater and sort them by number of 
events, descending. If the modifier key (Control on Windows, Command on Mac) is down while 
selecting from the popup the number selected refers to skill level.
A new button on the home screen allows users to view an extended description of any selected 
event.
The Pelican picture on the home screen is now user changeable. A number of pictures are avail-
able within Book’em!, and any picture placed in the Book’em folder with the name MyPicture 
can be used. See the section “Home Page Pictures” below for specs required.
Users may select a platform interface regardless of the type of computer being used. A Windows 
interface can be used on a Macintosh and a Mac interface can be used on Windows. The primary 
functional difference is that buttons can get focus with the Windows interface and are part of the 
TAB order.
A data change log system keeps track of all changes to the data. This tends to slow the program 
down somewhat and is not recommended on slower computers. It is a user option; you may turn 
it on in Preferences.
The floating Windows menu has been supplemented with a contextual menu, accessed with a 
right-click on Windows and a Command-click on Macintosh. The click must be within an active 
window but not on a button.
All on-screen entry and browser forms have been redesigned for clarity and easier navigation. 
All menus have been redesigned for clarity and consistency.
The settings for event window positions are now local to each computer.
All date areas are now wide enough to display four digit years. This is necessary to ensure year 
2000 compliance. It is recommended that users set system controls to display 4-digit years. On 
Macintosh this is done in the Date & Time Control Panel, in Windows it is done in the Regional 
Settings Control Panel.
All windows except alerts may now be dragged by the title bar.
Pressing Command-S (Macintosh) or Control-S (Windows) may modify font settings for the Re-
curring Event list on the left side of the Home Screen (Pelican). This setting is made for each 
computer.
New picture library allows more efficient storage of location maps. This library allows a single 
map to be used for multiple locations.
Buttons are now tabbable on Windows. Both the Windows and Macintosh standard interface and 
appearance guidelines are more closely adhered to.
One-at-a-time direct label printing to Labelwriters such as CoStar is possible without switching 
the default printer. This feature is currently working on Macintosh and will be added for Win-
dows in the near future, if demand warrants.
And perhaps most important, Book’em! Version 3 accepts a universal password not tied to your 
business name that allows unlimited user connections. You will receive this in the event the de-
veloper dies or wins the lottery.
Synchronization



The main and remote computers must start with the same datafile. Copy the main datafile to each 
remote computer. If you use single-user Book’em! move the entire Book’em! folder to the re-
mote machines. If you use client-server Book’em!, you will need to use the single-user version 
on the remotes.
To use the synchronization feature, the main database must be set to “Master” in the Synchro 
Setup dialog, available from the Utility menu at the Home screen. 
Each remote computer must be set to “Remote” in the same dialog. Each remote computer must 
be set to a different number, from 1 to 9.
When a remote computer wishes to update the main database, choose “Send Synch File” from 
the Utility menu. A file called Synch_n where n is the computer number, is created in the 
Book’em! folder. The copy of Book’em! on the remote machine must not be used until the syn-
chronization is complete and the main data file copied over.
Copy the Synch_n file to the master computer’s Book’em! folder if running single-user, or to the 
4D Client folder of any client running client-server Book’em!. 
From the Utility menu of the master, choose “Receive Synch File.” The user will be able to se-
lect the synch file to apply. Synch files from multiple remotes may be received sequentially.
When the master database is completely updated, the entire datafile from the master (named 
Book’em!.data on Macintosh and Book’em!.4dd on Windows) must be copied to each remote, 
replacing each remote’s datafile. The datafile may be compressed with CompactPro, WinZip, 
StuffIt, etc. for more efficient file transfer.
At the end of a synchronization, the master and each participating remote will have identical da-
tafiles.
The file transfers may be done with removable media (Zip, Jaz, Syquest, etc.), over a local net-
work, by direct modem connection, or over the Internet.
Passwords
In previous versions of Book’em! users could simply enter their names when logging on.
In Version 3, in order to take advantage of the new calendar contact management features, 
Book’em! needs to know all of the users who access the database, and who is logged on at any 
given time.
You may optionally require passwords to be entered at log-in. A user or users may be designated 
as Administrator, who will have the power to set password parameters, modify the return ad-
dress, set system preferences, establish synchronization, and run the reindexing utility. Even if 
passwords are not required for users, it is strongly recommended that the administrator have one.
Preferences
Preferences are now set at 3 different levels. 
• System Level. These settings may be made only by administrators and determine general system 

and data handling properties. Includes items such as table reference, date print formats, invoice 
dates, sales tax settings, payroll period, reservations mechanism defaults, set invalid addresses 
to no mail, etc.

• User Level. These setting may be made by each user. They include show at startup for the Cal-
endar, Address Book and One-Time list, active calendar date color, home page picture, default 
sorts, double-click speed, and past events shown.



• Computer Level: These settings are made for the computer being used and may be set by any 
user. Includes platform interface, labelwriter driver, home screen list font, event window posi-
tions, label format, etc. Some of these settings are made simply by remembering the last usage.

Home Screen Pictures
May be selected from a popup menu in Preferences. Several are included with the program. By 
selecting ‘Custom’ from the menu, a picture named “MyPicture” located in the Book’em or 4D 
Client folder will be used.
The recommended specs for the picture are: 72 dpi, size 360 wide by 302 tall, color indexed to 
the web 216 palette. Notice that the visible area is the lower right portion. Format may be PICT, 
.bmp, .jpg, .gif.

Bookʼem! 2.5.3 
Bugs Fixed:
Choosing "One-Time Events" from the Events popup at the bottom of the Customers' list screen 
caused errors if an event name was longer than 27 characters.
On Macintosh, the list of customers sometimes did not appear when the print button was clicked 
from an event window, preventing confirmation letters from printing.
Rescheduling into a one-time event did not work.
On very slow networks, the Pelican would sometimes not open at startup without choosing a 
menu command.
Errors were fixed that prevented more than one record to be opened in the Check Duplicates 
window.

Bookʼem! 2.5 
Bugs Fixed:
Bugs have been identified and fixed in Rescheduling, Mail Merge, Find Duplicates, Payroll, Pay-
roll Records, Credit Accounts, and the Discount List on Invoices. (all were minor except Re-
scheduling, which was a major pain.)
New Features:
Expanded Event Definitions. Events may now have a departure location different from the ac-
tual location. You may refer to either or both in letters and confirmations, and use the map and 
directions of either in confirmation letters.
Event difficulty and descriptions may be entered; a future version of Book’em! will feature print-
ing of promotional letters containing this information, plus (optionally) pictures and profiles of 
the guides/instructors assigned to the event. This information can be made available to your web 
site.
Book’em! now correctly recognizes a zero in the Size Limit field as meaning registration is un-
limited.



If any changes are made to a recurring master, and there are future occurrences, you’ll be able to 
apply the changes to future occurrences that contain the old default values. This may be applied 
to the fields of your choice when the Master’s record is saved.
Expanded Customer Definitions. In the main customer entry screen, the Details button will al-
low entry of the person’s height, weight, special diet,  medical notes, and skill level. If any of 
these items are entered they will be printed on rosters. Moved to the Details page from the main 
page are credit cards, birthdates, and event date statistics.
Expanded Staff Definitions. In the main staff entry screen, the Profile button will allow entry of 
a text profile and photograph of the employee. The next version of Book’em! will print these on 
promo sheets along with event descriptions for customers making inquiries.
Sales Tax. Different sales tax rates may now be set for each district you do business in, along 
with the date the rates become effective. Setting rates is done in the Invoices section of Prefer-
ences.
Tax District is now part of the Location definition. One district is designated as the “home dis-
trict” and any locations not specifically tagged is assumed to be in the home district.
Book’em! will calculate the taxes due for each district for any specified date range by selecting 
Sales Tax Totals from the Financial menu.
Locations. Locations are more important to the way Book’em! keeps track of things than before. 
Tax rates, user days, and some new reporting abilities are tied to locations.
Version 2.5 allows direct access to all locations from the new Records menu at the Pelican. It is 
recommended that you examine this list and correct errors, such as the same location entered 
more than once with different spellings.
If a location’s record is opened from this list, and the Change Location Name button is clicked, 
and the name of another location is entered, Book’em! will find all events tied to the record cur-
rently open and change the connection to the one being changed to. Remember that the map and 
directions of the record being changed will be deleted.
Keywords. The new Replace button in the Apply Keywords dialog at any of the People file list 
screens will replace the selected keyword with another (new or existing) in records containing it. 
The replace may optionally be applied to the current selection only or to the entire file.
Postal Return Handler. The new Send to List button on the Postal Return Handler provides a 
handy new tool to use to create selections of customer records.
Find Duplicate Customer Records. A new “Find Dupes” button on the main customer entry 
form and on the smaller customer form used when making reservations will look for possible 
duplicates to the current customer being entered. Any records with matching combinations of last 
name/first name, last name/zipcode, last name/phone number, or last name/first 4 characters of 
the address are found. If the Command key (Macintosh) or Control key (Windows) is down 
while clicking the button, any matching addresses will be found, although this search takes much 
longer than the others.
If any dupes are found, they’ll be displayed in a window. One may be selected and gone to, with 
the option of saving or cancelling the current entry.
Date Print Formats. Available on the General page of the Preferences dialog, you may now set 
which date formats are printed when Header, Long Date, or Short Date are included in a confir-



mation or mail merge letter. Select a date format, then select the format name(s) you want to use 
it. 
New Reports
* Receivables. Open the Receivables list and choose Report Editor from the Report menu. 
Choose Open from the File menu. Navigate to the Reports folder, select RECVBLS.4QR and 
print.
* User Days. The printed report is now ready, and is available either by selecting User Days from 
the Events menu or Print from the File menu at the Pelican.
* Income Summary. Shows money in/money out by date, for any date range. Available from the 
Print command at the Pelican.
* Income by Event. Details payments and receivables for all events occurring within a specified 
date range. Available from the Print command at the Pelican.
* Payment Status Report. From any event window, this is available from the Report menu.
* Individual People Records. Any record from Customers, Staff, or Contacts may be printed full-
page by choosing Print from the File menu at the records main entry screen.
Layout Redesign. Many screen layouts have been rebuilt to make them easier to read and work 
with. 
Above the Notes field in all people file records is a button which expands the notes area to full-
window.

Bookʼem! 2.1.2 
Bugs Fixed:
An error that occurred when the last reservation in a trip was cancelled or rescheduled has been 
fixed.
Some timing problems that caused long delays in quitting the database have been corrected.
New Features:
A temporary word processor has been added to the Windows version so that confirmations and 
mail-merge letters may be produced while we wait for the full word processor.
4D Tools, a utility to repair damaged datafiles, is ready and is included.
Validation numbers may now be entered when credit cards are entered as payment type.
Serial number entry deadlines may be extended to a specific future date.

Bookʼem! 2.1.1 
Bugs Fixed:
Setting ‘taxable’ checkbox in invoice’s line items now correctly updates the totals.
More than 6 guides will now print on rosters.
Some fonts have been changed for legibility.



Scrollbar problems have been fixed.
When the “Expect Others” preference is deselected (which causes the first line item created for a 
new party’s invoice to be equal to the size of the party), and the party qualifies for an automatic 
discount, the discount is applied to the whole party.
Trip Payment Reports now work properly.
New Features:
The Import and Export Editors have been added. Access them from the ‘people’ file you want to 
import to or export from.
All rosters from any day (with the option of restricting the start times) may be printed with one 
command. Choose ‘Print’ from the Pelican to access this.
E-Mail addresses may now be entered for customers, and in your return address.
Control-double-click (Windows) or command-double-click (Macintosh) a reservation to open its 
invoice.
Individual messages may be added to (and saved with) invoices. If no individual message is en-
tered the default message set in Preferences is used.
New tab controls in Preferences.


